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11..  IInnttrroodduuccttiioonn  
Merci du temps que vous allez consacré à l’évaluation de Formula One e.Report Designer. Ce document a été conçu pour 
donner au lecteur un aperçu général des fonctionnalités du logiciel en une très courte période de temps. Les étapes dans ce 
guide vous prendront approximativement 30 minutes. 

Formula One e.Report Designer est un outil flexible et convivial dédié aux développeurs qui ont besoin d’agréger des 
informations d’affaires depuis des sources de données diverses, et de publier les données sur le Web sous forme de rapports 
professionnels.  

Formula One e.Report Designer permet aux développeurs d’extraire, de formater et de générer efficacement des données. 
Formula One e.Report Designer accède aux données depuis une variété de sources, incluant les objets Java au sein 
d’applications, XML, les bases de données, les EJBs (Enterprise JavaBeans), et les fichiers texte. Les développeurs peuvent 
alors formater les données de multiples façons grâce aux assistants intuitifs et à un éditeur WYSIWYG complet. Finalement, 
l’outil peut générer le contenu dans de nombreux formats visuels et d’impression. 

Le logiciel Formula One e.Report Engine inclut un environnement de conception visuel (Designer) et une API (Engine).  

22..  AAvvaanntt  ddee  DDéémmaarrrreerr    
Avant toute chose, vous devez installer la version d’évaluation de Formula One e.Report Designer (limitée à 30 jours) sur votre 
machine. Les instructions qui suivent vous guideront au travers des différentes étapes nécessaires pour l’installation sur les 
plates-formes Win32. 

Pré-requis pour la version d’évaluation (et non pas les pré-requis généraux pour le produit en version définitive) : 

• Système d’exploitation Win32 (pour utiliser la plate-forme Java fournie) 

• Navigateur Web Standard (pour visualiser les sorties e.Report au format DHTML) 

• Reader Adobe Acrobat (pour visualiser les sorties e.Report au format PDF) 

Avant de commencer l’évaluation, vous devez : 

1 - Installer Formula One e.Report Designer 

2 - Créer une connexion ODBC qui référence les données fournies en exemple 

Etape 1 : Installation de Formula One e.Report Designer  

Option 1 : 

• Téléchargez une copie d’évaluation de Formula One e.Report Engine (qui inclut e.Report Designer sur le site de 
KAPITEC SOFTWARE) :  

http://www.kapitec.com/downloads/ReportingEngines/ReportingEngines.htm 

• Sélectionnez la version d’évaluation de Formula One e.Report Engine 

• Téléchargez le fichier FormulaOneERD-Evaluation.exe (taille approximative 98 Mo) et mettez-le directement sur le C:\ 

Installez Formula One e.Report Designer : 

• Double-cliquez sur C:\FormulaOneERD-Evaluation.exe 

www.kapitec.com
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Une fois l’installation terminée, un nouveau répertoire est créé : C:\Program Files\Formula One\F1eRE7-Eval. Ce répertoire 
contient tout ce dont vous avez besoin pour exécuter le Designer, comme les fichiers JAR de l’Engine, les manuels PDF, le 
Javadoc, et toute une série d’exemples de code. 

Option 2 : 

• Installez Formula One e.Report Designer à partir du CD-ROM d’évaluation Formula One Reporting (Formula One 
e.Report Engine) qui vous a été fourni. Merci de vous référer aux instructions décrites ci-dessus. 

Etape 2 : Configuration du Driver ODBC pour la Base de Données du Guide 
d’Evaluation 

Certains des rapports utilisent un driver ODBC pour accéder à une base de données Microsoft Access. Si vous voulez évaluer 
les possibilités de reporting du logiciel à partir de sources de données relationnelles, il vous faut suivre ces étapes : 

• Sélectionnez Démarrer / Paramètres / Panneau de Configuration / Outils d’administration / Sources de données (ODBC)  

• Cliquez sur Sources de données système / Ajouter… 

• Sélectionnez Microsoft Access Driver (*.mdb) / Terminer 

• Saisissez sfdata comme nom de la source de données  

• Cliquez sur Sélectionner le répertoire… et naviguez jusqu’au fichier sfdata.mdb se trouvant dans C: \Program 
Files\Formula One\F1eRE7-Eval\files\data 

• Cliquez sur OK / OK / OK 

33..  DDéémmaarrrraaggee  ddee  FFoorrmmuullaa  OOnnee  ee..RReeppoorrtt  DDeessiiggnneerr  
Pour lancer Formula One e.Report Designer depuis le menu Démarrer, sélectionnez Démarrer | Programmes | Formula One | 
Formula One e.Report Designer 7 - Evaluation. Cela invoque le fichier script run.bat, qui se trouve dans le répertoire C:\Program 
Files\Formula One\F1eRE7-Eval\bin directory. Quand une template de rapport est créée dans le Designer, elle est stockée dans 
un fichier de définition de rapport appelé conception de rapport (report design). Ce fichier a pour extension .jod. 
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44..  CChhaarrggeemmeenntt  eett  VViissuuaalliissaattiioonn  ddee  RRaappppoorrttss  
Formula One e.Report Designer vous permet de concevoir et de formater visuellement votre rapport. L’interface utilisateur est 
très similaire à celles trouvées dans Microsoft Access. Pour charger un des exemples de rapports, sélectionnez File | Open à 
partir du menu. Naviguez jusqu’au répertoire C:\Program Files\Formula One\F1eRE7-Eval\files\designs\sfdata et sélectionnez le 
fichier de conception de rapport charts.jod. Ce fichier montre à quoi ressemble un exemple de rapport avec des courbes et des 
graphes, et comment il fonctionne dans Formula One e.Report Designer. 

Afin de visualiser comment les données du rapport vont apparaître pour la conception du rapport, cliquez sur l’onglet Preview 
(Aperçu) situé en haut du rapport. Le rapport est alors généré et s’affiche dans la fenêtre Preview. 
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Formula One e.Report Designer vous permet de prévisualiser votre rapport. 

C’est le processus de base que vous utilisez pour développer vos rapports. Une fois les changements effectués à la conception, 
vous devez prévisualiser dans la fenêtre Viewer. Si vous avez déjà exécuté le rapport, vous devez cliquer sur l’icône Refresh 
(Rafraîchir) dans la barre de menu de la fenêtre Viewer de e.Report Designer ou sélectionner le menu View -> Refresh. 

55..  FFeennêêttrree  VViieewweerr  
L’onglet Preview de Formula One e.Report Designer utilise le module Viewer pour visualiser et exporter les rapports. Le module 
Viewer peut également être utilisé dans votre propre application Java SWING. 

La barre d’outils fournit de nombreuses options pour naviguer dans le rapport (Suivant / Précédent / Début / Fin). De plus, vous 
pouvez aussi aller à un numéro de page spécifique dans un rapport (Survol de chaque icône de la barre d’outils avec la souris 
pour avoir une description de chacune des fonctions des icônes sous forme de menu pop-up). 

Vous pouvez aussi faire des zoom avant et arrière pour visualiser les données du rapport en choisissant le facteur de zoom 
dans la barre d’outils (facteur de 50% à 200% de la taille du rapport). Vous pouvez scroller l’écran en utilisant les ascenseurs ou 
en cliquant et glissant la fenêtre. 

Les règles en haut à gauche du rapport indiquent la taille réelle du rapport. Cette information est très souvent utile lors de la 
configuration d’un rapport pour s’adapter à un format spécifique de papier ou pour que le rapport s’affiche correctement une fois 
exporté dans plusieurs formats de fichiers. La page courante et le nombre total de pages du rapport sont affichés en bas à 
gauche de la fenêtre Viewer. 
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66..  TTaabbllee  ddeess  MMaattiièèrreess  //  ZZoooomm  AAvvaanntt    
L’icône de la Table des Matières (Table of Contents - ToC) dans la barre d’outils est d’un intérêt particulier. En cliquant sur cette 
icône on affiche ou on cache la fenêtre Table des Matières. La fenêtre Table of Contents apparaît à gauche de la fenêtre de 
visualisation avec une structure arborescente. 

 
Formula One e.Report Designer génère automatiquement une Table des Matières. 

Cette structure arborescente représente la "structure" de votre rapport. Une structure de rapport comprend les différentes 
Sections des rapports, avec des Groupes et les zones En-tête/Pied-de-page. 

La Table des Matières facilite la visualisation et l’analyse de rapports importants ayant  de multiples niveaux. En cliquant sur un 
élément, on affiche ses données liées sur le côté droit de la fenêtre. Une barre de séparation sépare les fenêtres Table of 
Contents et Viewer. Les fenêtres peuvent être redimensionnées à la souris. 

La Table des Matières est un mécanisme dans lequel la fonction Zoom Avant (Drill Down) est fournie. Le comportement de la 
fenêtre ToC/Drill Down peut être configuré dans la fenêtre du Designer depuis le menu Tools | Options | Drill Down. Vous 
pouvez choisir si vous voulez afficher des résumés et/ou des détails. Vous pouvez aussi choisir les niveaux de Table de 
Matières que vous voulez afficher.  

77..  IImmpprreessssiioonn  eett  EExxppoorrttaattiioonn  ddee  RRaappppoorrttss    
Peu de rapports sont de grande utilité sans la possibilité de les générer dans des formats que les autres utilisateurs peuvent 
visualiser et imprimer. Pour imprimer le rapport, cliquez sur l’icône Print (Impression) dans la barre d’outils de la fenêtre Viewer. 
La boîte de dialogue de l’imprimante s’affiche alors. Si l’imprimante par défaut est la bonne, cliquez sur OK, et le rapport sera 
imprimé sur l’imprimante spécifiée. 

Formula One e.Report Designer peut également exporter le rapport dans des formats variés tout en conservant la plupart des 
informations sur le formatage du rapport, telles que les couleurs, les polices, la mise en page, etc. Les utilisateurs peuvent 
exporter leurs rapports dans des formats PDF, DHTML, XML, Excel, et CSV. Pour exporter votre rapport, cliquez sur l’icône 
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Generates output in different file formats (première icône de la barre d’outils). Dans la boîte de dialogue, sélectionnez le format 
d’export (DHTML, HTML, Excel, CSV, PDF, JOI, XML, Email) et indiquez le nom du fichier. 

Pour ce rapport, sélectionnez le format PDF dans la boîte de dialogue Export et cliquez sur OK. Acceptez le nom par défaut et 
sauvegardez le fichier PDF sur votre bureau. Ouvrez alors le nouveau fichier PDF qui se trouve sur votre bureau. 

 
Formula One e.Report Designer fournit des rapports au format PDF. 

Formula One e.Report Designer est capable de produire des rapports au format PDF, tout en conservant une haute résolution. 

Vous pouvez également essayer une procédure similaire pour exporter le rapport au format DHTML, qui propose de loin une 
meilleure résolution et une meilleure clarté que le format HTML, en raison des possibilités de positionnement absolu du DHTML.  

88..  AApppplliiccaattiioonn  DDaattaa  HHaannddlleerr  
L’aspect unique de Formula One e.Report Designer est sans doute la facilité avec laquelle il peut être utilisé pour générer des 
rapports depuis des données d’objets au sein de votre application Java. Formula One e.Report Designer utilise un mécanisme 
de (mapping) objet/structure relationnelle (le Application Data Handler), pour comprendre et extraire les données résidant dans 
les objets de votre application Java.  

Typiquement, avec l’utilisation de bases de données relationnelles, les utilisateurs sont habitués à travailler avec des concepts 
Table/Colonnes. Si on étend ce concept aux objets, on peut penser aux données applicatives en terme d’Objets/Champs 
Méthodes, où la Table est l’objet et les colonnes sont les champs et les méthodes de l’objet. Les données pour votre application 
peuvent provenir de n’importe quelle source ; la seule contrainte est que la donnée soit disponible en tant que classe publique,  
ainsi Formula One e.Report Designer peut utiliser l’API Refection Java pour extraire les données et générer un rapport. 
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Le reporting de données applicatives procure de nombreux avantages par rapport au modèle traditionnel de reporting de 
données de base de données. Le reporting de données applicatives est particulièrement bien adapté pour les applications de 
type Internet/Intranet, tout comme pour les applications distribuées. Le reporting de données applicatives peut aussi 
énormément réduire la charge de votre base de données, et peut améliorer les performances, et réduire le transfert réseau 
inutile de données. Grâce à l’Application Data Handler, vous pouvez tirer partie des bénéfices du reporting de données 
applicatives tout en conservant la facilité de développement. Les données dans vos objets Java sont accessibles comme si elles 
étaient dans une base de données SQL, fournissant ainsi une manière simple de spécifier les données devant être montrées 
dans un rapport. 

99..  FFeennêêttrree  DDeessiiggnn  
Regardons maintenant quelles sont les caractéristiques du Designer. Pour cela cliquez sur l’onglet Design situé en haut de la 
fenêtre. La fenêtre Design a deux sections principales : la fenêtre Structure du rapport à gauche, et le Formulaire Designer à 
droite.  

 
La fenêtre Design de Formula One e.Report Designer montre la structure du rapport sur la gauche, et sa mise en page 

sur la droite. 

Les deux sont conçues pour fonctionner ensemble, aussi l’une est dépendante de l’autre. La fenêtre Structure du rapport affiche 
les différentes parties du rapport : En-tête du Rapport, En-tête de la Page, En-tête du Groupe, Détails, Pied-de-Page du Groupe, 
Pied-de-Page de la Page, et Pied-de-Page du Rapport. Dans Formula One e.Report Designer, chacune de ces parties est 
appelée "zone". Les éléments montrés à la droite de chaque zone sont contenus dans cette zone. Chaque zone a ses propres 
propriétés. Par exemple, une zone En-tête de Rapport est imprimée seulement une fois au démarrage du rapport, etc. 

En regardant la fenêtre Formulaire du Designer sur la droite, vous remarquerez des éléments avec différentes valeurs texte. De 
tels éléments s’apparentent à des “Contrôles”. Certains de ces contrôles sont des étiquettes, alors que d’autres sont des 
champs données, des formules, des images, des courbes, etc. Pour en savoir plus sur chacun de ces contrôles, double-cliquez 
dessus. Une boîte de dialogue multi-onglets contenant leurs propriétés s’affiche alors. 

www.kapitec.com
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Vous pouvez déplacer et redimensionner les contrôles directement à la souris. Vous pouvez sélectionner plusieurs contrôles en 
appuyant sur la touche clavier Ctrl et en sélectionnant les contrôles ou en glissant un lasso autour de plusieurs éléments. Pour 
visualiser les différentes options de formatage disponibles pour un type de contrôle spécifi que, cliquez sur le contrôle et 
sélectionnez Format | Control dans le menu Options. Certains des attributs communément utilisés, tels que les polices, couleurs, 
alignements, sont aussi disponibles dans la barre d’outils pour les rendre plus facilement accessibles.  

 
Formula One e.Report Designer fournit des possibilités intégrées et pratiques de formatage. 

Pour visualiser les détails sur votre source de données, cliquez sur le menu Data -> Data Source Browser. Les détails 
concernant votre source de données (noms de table, noms de colonne, type de données de la colonne, valeur par défaut, etc.) 
sont affichés.  

 

www.kapitec.com


 

 
 
Guide d’Evaluation de Formula One e.Report Designer 

 

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com 
Formula One est une marque déposée de ReportingEngines, une division d’Actuate Corporation. 

- 11 - 

 
Le Gestionnaire de Données (Data Manager) de Formula One e.Report Designer vous permet de visualiser la structure 

de votre source de données. 

En cliquant sur l’onglet Relationships du Data Manager vous affichez les relations clé primaire-étrangère qui ont été définies 
entre différentes tables. Les utilisateurs qui travaillent avec des bases de données pensent souvent en termes de 
tables/colonnes et requêtes SQL. Grâce à l’Application Data Handler, les données dans vos objets Java sont accessibles 
comme si elles étaient dans une base de données SQL, fournissant un moyen simple de spécifier les données devant être 
visibles dans un rapport. 

Dans Formula One e.Report Designer, la requête qui sera exécutée pour votre rapport est partiellement auto-générée à partir 
des éléments que vous avez placé dans la fenêtre Formulaire du Designer. Afin de visualiser la requête SQL basée sur le 
dernier état de votre conception, cliquez sur le menu Data -> Section SQL Query  Editor. Une boîte de dialogue s’affiche alors 
avec la requête à l’intérieur.  

www.kapitec.com
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Formula One e.Report Designer vous permet de visualiser et de modifier la requête SQL pour chaque section du 

rapport. 

1100..  TTyyppeess  ddee  RRaappppoorrttss    
Formula One e.Report Designer simplifie le développement de nombreux types de rapports incluant :  

• Rapports tableaux croisés 

• Rapports multi-tables 

• Différents niveaux de regroupement  

• Sections multiples (Maître-Détail)  

• Rapports de paramètres  

Un rapport tableaux croisés (crosstab report) est un rapport tabulaire dans lequel les données sont présentées comme une 
matrice avec des critères de groupes définis aussi bien sur l’axe X que l’axe Y. De multiples regroupements peuvent être défini s 
pour chacun des axes. Chargez le rapport AdvancedCrosstab en suivant les étapes ci-dessous. 

Depuis le menu principal, sélectionnez File -> Open. Sélectionnez “No”, si vous y êtes invité(e), dans le dialogue de confirmation 
de sauvegarde (Load Confirmation). Sélectionnez le fichier crosstab2.jod et cliquez sur “Ouvrir.” 
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Formula One e.Report Designer avec le rapport crosstab2.jod en mode conception. 

Cliquez sur l’onglet Preview pour visualiser à quoi ressemble un rapport tableaux croisés. 

 
Formula One e.Report Designer avec le rapport crosstab2.jod en mode Aperçu. 
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Un rapport à sections multiples est conçu pour des données dont les tables de la base de données ont une relation Maître -Détail 
logique. Chaque section d’un rapport à sections multiples a sa propre requête. Cependant, une telle requête doit se référer à 
des objets dans d’autres sections et créer une dépendance. Chargez et lancez le rapport multiplesections.jod pour voir un 
exemple de ce type de rapport. Référez-vous aux mêmes instructions que celles que vous avez suivies pour ouvrir le rapport 
tableaux croisés.  

 
L’onglet Design montre la structure et la mise en page du rapport multiplesections.jod.  

Depuis le menu Data, vous pouvez examiner chacune des requêtes étant exécutées dans le rapport : 
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Formula One e.Report Designer vous laisse visualiser chacune des requêtes SQL dans le rapport. 

1111..  DDééppllooiieemmeenntt  
Une fois que vous avez fini de développer un rapport, vous pouvez le déployer auprès de vos utilisateurs finaux. Actuate 
propose diverses options de déploiement pour répondre à des besoins divers. Par exemple, vous pouvez générer et visualiser le 
rapport avec Formula One e.Report Engine au sein d’une application Java autonome. Vous pouvez également inclure le moteur 
e.Report au sein d’un serveur d’applications, l’appeler depuis une servlet, ou l’encapsuler avec du JSP (Java Server Pages). Il y 
a plusieurs exemples de déploiement fournis avec le logiciel. Merci de vous référer aux exemples (C:\Program Files\Formula 
One\F1eRE7\Code Samples). 

1122..  CCoonncclluussiioonn  
Après avoir suivi ce guide d’évaluation vous devez avoir une meilleure idée sur la manière dont Formula One e.Report Designer 
fonctionne et sur ses nombreuses fonctionnalités. Et plus particulièrement, sur les fonctionnalités et les bénéfices qui sont 
démontrés : 

• Reporting 100% Pure Java : pas de code natif spécifique à la plate-forme. 

• Application Data Handler : simplifie le reporting de données depuis des objets Java applicatifs.  

• Reporting de base de données : rapport depuis des données relationnelles. 

• Support de nombreux formats dont DHTML, PDF, XML, Excel et CSV : informations livrées dans de nombreux formats 
pour répondre aux contraintes des utilisateurs pour la visualisation en haute résolution de contenu.  

• Fonctionnalités interactives de visualisation : les utilisateurs peuvent facilement trouver les informations pertinentes dans 
les rapports grâce à la Table des Matières. 
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• Support de types de rapports : tableaux croisés, rapport à sections multiples, graphes/courbes, formulaires, lettres, 
rapports de paramètres. Développement basé sur des assistants pour tous les types de rapport les plus répandus 
pour une productivité optimale du développeur. 
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AAnnnneexxee  ::  CCoonnssttrruuccttiioonn  dd’’uunn  RRaappppoorrtt  
Il s’agit d’un didacticiel pour créer un rapport depuis le départ en utilisant Formula One e.Report Designer. 

N° ETAPE DESCRIPTION 

1 Démarrez e.Report 
Designer 

Lancez le designer depuis le menu Démarrer, sélectionnez 
Démarrer  Programmes / Formula One / Formula One e.Report 
Designer - Evaluation 

2 Configurez le Driver 
ODBC 

Ce didacticiel crée un rapport qui a besoin d’un driver ODBC pour 
accéder à une base de données d’exemple MS Access. Merci de 
suivre les étapes ci-dessous pour configurer la base de données, 
à moins que cela n’ait déjà été fait. 

• Cliquez sur Paramètres / Panneau de configuration / Outils 
d’administration / Sources de données ODBC 
• Cliquez sur Sources de données Système / Ajouter…  
• Sélectionnez Microsoft Access Driver (*.mdb) / Terminer 
• Saisissez Sfdata comme nom de la source de données 
• Cliquez sur sélectionner le répertoire et naviguez jusqu’au 
fichier sfdata.mdb se trouvant dans C:\Program Files\Formula 
One\F1eRE7\files\data 
• Cliquez sur OK / OK / OK 

3 Connectez la Base 
de Données 

A cette étape du didacticiel, on se connecte à la base de données 
Sfdata créée dans l’étape précédente.  

• Sélectionnez depuis le menu Data / Connect… Vérifiez que 
“Detected Drivers” est coché et que 
sun.jdbc.odbc.JdbcOdbcDriver est sélectionné. Saisissez 
jdbc:odbc:sfdata comme URL de la base de données. 
Sélectionnez Apply (Appliquer), puis Close (Fermer). 

 
4 Créez un Nouveau 

Rapport 
Créez un nouveau rapport en cliquant sur  l’icône Page Blanche à 
gauche de la barre d’outils ou en sélectionnant dans le menu File | 
New. 
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5 Sélectionnez un 
Style de Rapport 

• Dans la boîte de dialogue “New Report”, choisissez “Multiple 
Table”. 
• Cliquez sur OK. 

 
 

6 Sélectionnez les 
Champs de la Base 
de Données pour le 
Reporting 

Une fois l’assistant Multiple Table Report lancé, cliquez sur Next 
pour commencer à créer le rapport. Sélectionnez les champs pour 
ce rapport en sélectionnant le champ et en l’ajoutant avec la flèche 
pointant à droite.   

Sélectionnez les champs depuis la table items :  
• description  
• pricequote 
• quantity 

 

7 Sélectionnez les 
Regroupements 

• Cliquez sur Next pour sélectionner Grouping 
• Groupez par customers.customName et par orders.orderid.  
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8 Sélectionnez les 
Critères de Tri 

Cliquez sur Next pour choisir Sorting Criteria. 
• Sélectionnez customers.customName, puis orders.ordered, et 
enfin items.description comme critères de tri. 

 
 

9 Sélectionnez les 
Jointures les Filtres 

Choisissez Auto Detect pour trouver automatiquement les 
jointures, sinon créez à la souris la relation entre les champs d’une 
table à une autre. 
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• Cliquez sur Next 

10  Indiquez le Titre et 
le Pied de Page 

Dans l’onglet “Data” de l’assistant Multiple Table Report, nous 
ajoutons un titre et un pied-de-page au rapport. 

• Saisissez “Order Summary” comme titre du rapport. 
• Saisissez “Copyright: Any Corporation” comme pied de page. 
• Cliquez sur Next. 

11 Sélectionnez les 
Styles de Rapport 

Dans l’onglet “Format” de l’assistant, nous pouvons paramétrer 
des premières options de formatage. 

• Sélectionnez “Divider Lines” pour le style du rapport. 
• Décochez “Show Gridlines,” pour désactiver cette 
fonctionnalité. 
• Cochez “Add Date to report header”. 
• Choisissez Finish. 

12 Visualisez la 
Conception du 
Rapport 

La conception du rapport apparaît dans la fenêtre Design. A partir 
de cet écran, vous pouvez modifier n’importe lequel des éléments 
créés par le Designer. 

 
 

13 Prévisualisez le 
Rapport 

Cliquez sur l’onglet Preview pour générer le rapport dans la 
fenêtre Preview. Ouvrez la Table de Matières en cliquant sur la 
loupe précédante SEC_00. 
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14 Modifiez les 

Contrôles dans le 
Rapport 

Nous référencerons plusieurs contrôles dans une formule et un 
graphe plus tard dans ce didacticiel. A cette étape, nous 
renommons l’identifiant du contrôle pour qu’il soit plus facile à 
identifier : 

• Retournez à la fenêtre Design en cliquant sur l’onglet Design. 
• Dans la section Detail, double-cliquez sur le contrôle Items. 
Description et renommez l’Identifiant du Contrôle en 
Description. 
• Cliquez sur OK. 

Suivez les mêmes étapes pour : 
• Renommer les identifiants Items.Pricequote en Price, et 
Items.Quantity en Quantity. 

15 Utilisez les 
Formules 

Ensuite, nous allons ajouter un champ formule dont la valeur sera 
calculée : 

• Ajoutez un Label Control après Quantité dans Group Header 

en sélectionnant l’icône Label  dans la barre d’outils. Le 
libellé de l’étiquette doit être : Total. 
• Etirez et positionnez l’étiquette comme nécessaire. 

 
Ajoutez une formule dans Detail Section (DTL_00) :  

• Sélectionnez l’icône formule  dans la barre d’outils et 
cliquez dans la section Detail, sous la nouvelle étiquette “Total”, 

www.kapitec.com


 

 
 
Guide d’Evaluation de Formula One e.Report Designer 

 

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com 
Formula One est une marque déposée de ReportingEngines, une division d’Actuate Corporation. 

- 22 - 

pour insérer la formule. 

 
Insérez une formule pour calculer la valeur totale pour chaque 
produit. Nous utilisons les identifiants renommés, quantité et prix, 
dans la formule. 

• Dans la fenêtre Formule, saisissez price * quantity  (Appuyez 
sur le bouton pour voir le Générateur de Formules). 
• Cliquez sur Change Format et sélectionnez Currency (devise) 
/ Number. 
• Cliquez sur OK. 
• Double-cliquez sur la nouvelle formule et renommez 
l’identifiant du contrôle en ‘Total’. 
• Prévisualisez le rapport. 

 
16 Formatez le rapport Ensuite, nous modifierons le design du rapport pour améliorer le 

"look-and-feel" des rapports. 

Pour modifier la taille du contrôle : 
• Sélectionnez la formule Total, appuyez sur Ctrl et 
sélectionnez le libellé Total. Faîtes un clic droit, choisissez 
Alignement, Make Widths Equal et ensuite Left Edges. 
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Paramétrage de l’alignement : 

• Sélectionnez le contrôle Items.description et appuyez sur 

l’icône justifier à gauche  
• Etirez par la gauche le contrôle Description pour étendre la 
largeur du champ. 
• Ajustez le libellé Description dans le Groupe Header pour qu’il 
corresponde à la nouvelle largeur. 
• Etirez également les lignes dans la zone Group Header pour 
couvrir le nouveau libellé total et la longueur du champ 
description. 
• Sélectionnez le contrôle Total Formula, le contrôle Price Data, 
et le contrôle Quantity Data et appuyez sur l’icône justifier à 

droite  
• Dans Customer Header Zone, sélectionnez et supprimez le 
libellé customName. 
• Sélectionnez le contrôle Customers.Customname data et 
étirez-le par la gauche pour élargir le champ. 
• Sélectionnez le contrôle Customname data et appuyez sur 

l’icône justifier à gauche  
• Prévisualisez le rapport. 
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17 Visualisez la 
Requête SQL 

Maintenant, nous allons revoir la requête SQL générée 
automatiquement par le Designer : 

• Pour visualiser la requête SQL, sélectionnez Data -> Section 
Query Editor -> SEC_00 : 

 
 

18  Renommez la  
Table des Matières 

Dans cette étape, nous allons renommer le titre par défaut TOC 
pour montrer que les sections du rapport sont listées par 
Customer : 

• Sélectionnez Data -> Section Query Editor-> SEC_00. 
• Renommez Section ID en Customers. 
• Cliquez sur OK. 

 
• Prévisualisez le rapport. 
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• Retournez à la fenêtre Design. 

19 Ajoutez un Graphe 
dans le Rapport 

Maintenant nous allons ajouter un graphe au rapport. 
• Etirez Group Footer GFTR0_ORDERID vers le bas de la 
page (hauteur d’environ 3 pouces). 

• Insérez un graphe en cliquant sur l’icône graphe  dans la 
barre d’outils et ensuite en cliquant dans la section Group 
Footer GFTR0_ORDERID. L’assistant de courbes se lance 
alors. 
• Sélectionnez Next pour commencer à travailler avec 
l’Assistant de Courbes. 
• Sélectionnez ‘2D Vertical Comparison Bar Chart’ et cliquez 
sur Next. 

 
• Sélectionnez ‘Description’ pour l’axe X et cliquez sur Next. 
• Sélectionnez ‘Total’ pour l’axe Y et cliquez sur Next. 
• Ajoutez un titre à la courbe : Product Totals by Order. 
• Cliquez sur Finish. 
• Etirez la courbe sur toute la largeur et la hauteur de la page 
de la zone Order Footer. 
• Prévisualisez le rapport ; 
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20 Exporter le Rapport 
Généré 

Le rapport généré peut être exporté dans plusieurs formats.  Lors 

de la prévisualisation du rapport, appuyez sur l’icône  Export  
pour afficher les choix de format d’export. 

 
 

21 Sauvegardez la 
conception du 
rapport 

Le design du rapport peut être sauvegardé en cliquant sur File -> 
Save ou File -> Save As. 

22 Fin Fin du didacticiel. 
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